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m Introduction

This guide provides reference information on editing pages of the NA. It does not provide safety
information.

Be sure to obtain the NA-series Programmable Terminal User's Manuals, read and understand the safety
points and other information required for use, and test sufficiently before actually using the equipment.

(1) All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or
otherwise, without the prior written permission of OMRON.

(2) No patent liability is assumed with respect to the use of the information contained herein. Moreover,
because OMRON is constantly striving to improve its high-quality products, the information contained
in this manual is subject to change without notice. Every precaution has been taken in the preparation
of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is
any liability assumed for damages resulting from the use of the information contained in this
publication.

(3) Trademarks
» Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan
and other countries for OMRON factory automation products.

» Windows, Visual Basic, and Excel are either registered trademarks or trademarks of Microsoft
Corporation in the United States, Japan, and other countries.

» Other company names and product names in this document are the trademarks or registered
trademarks of their respective companies.

* Microsoft product screen shots reprinted with permission from Microsoft Corporation.

» The product pictures and drawings contained in this document are the graphical images, which may
be different from the actual articles.



Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and
workmanship for a period of twelve months from the date of sale by Omron (or such other period
expressed in writing by Omron). Omron disclaims all other warranties, express or implied.
Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED,
ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS
DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF
THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses
based on infringement by the Products or otherwise of any intellectual property right.

Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or replacement
thereof) the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or
credit Buyer an amount equal to the purchase price of the non-complying Product; provided
that in no event shall Omron be responsible for warranty, repair, indemnity or any other
claims or expenses regarding the Products unless Omron’s analysis confirms that the
Products were properly handled, stored, installed and maintained and not subject to
contamination, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Companies shall not
be liable for the suitability or unsuitability or the results from the use of Products in
combination with any electrical or electronic components, circuits, system assemblies or any
other materials or substances or environments. Any advice, recommendations or
information given orally or in writing, are not to be construed as an amendment or addition to
the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published
information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR
COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER
SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT
LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the
Product on which liability is asserted.




Application Considerations

I Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or
regulations which apply to the combination of the Product in the Buyer’s application or use
of the Product. At Buyer’s request, Omron will provide applicable third party certification
documents identifying ratings and limitations of use which apply to the Product. This
information by itself is not sufficient for a complete determination of the suitability of the
Product in combination with the end product, machine, system, or other application or use.
Buyer shall be solely responsible for determining appropriateness of the particular Product
with respect to Buyer’s application, product or system. Buyer shall take application
responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO
LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS
BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL
EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable
Product, or any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a
guide for the user in determining suitability and does not constitute a warranty. It may
represent the result of Omron’s test conditions, and the user must correlate it to actual
application requirements. Actual performance is subject to the Omron’s Warranty and
Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons. It is our practice to change part numbers when published
ratings or features are changed, or when significant construction changes are made.
However, some specifications of the Product may be changed without any notice. When in
doubt, special part numbers may be assigned to fix or establish key specifications for your
application. Please consult with your Omron’s representative at any time to confirm actual
specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical or proofreading
errors or omissions.
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1 Introduction

This chapter provides the list of questions and answers that arise from page editing on
NA-series PTs, as described in this manual. Refer to Chapter 2 for more details of each

article.

1-1 List of Questions and Answers

Questions

Answers

Details described in:

How can | display the setting fields of
Properties, Animations, or Events and
Actions for an object?

Select an item from the [View] menu at the top.

2-1-2 How To Display the
Properties Tab

How can | view description of each
function or object on Sysmac Studio?

Select “Description” from the context menu to
show or hide the description.

2-1-3 How To Display
Description of Objects

How can | deactivate an input object
such as a button (i.e. the control flag
function in NS)?

Uncheck the [IsEnabled] checkbox under
[Behavior] in the [Properties] tab page.

2-2-1 Settings to Enable
Input

How can | indirectly specify input
permission for an input object such as
a button (i.e. the control flag function in
NS)?

Select [Animations] — [Enable] in the
[Animations] tab page and set in [Expression]
the indirect specification condition.

2-2-1 Settings to Enable
Input

How can | perform show/hide settings
for objects (i.e. the control flag function
in NS)?

Open the [Properties] tab page and uncheck the
[IsVisible] checkbox under [Appearance].

2-2-2 Show/Hide Settings

How can | blink an object?

In the [Animations] tab page, select [Animations]
- [Blink] and set in [Expression] the indirect
specification condition.

2-2-3 Settings to Blink an
Object

There are several fields such as
[Variable], [Expression], or [Value] to
specify variables. What are the
differences between these three?

You can only specify variables in [Variable],
whereas you can not only enter variables but
also show arithmetic results in [Expression] and
[Value].

2-2-4 Differences between
Variable, Expression, and
Value

Can | find which functional object in NS
corresponds with which object in NA?

Refer to “2-3-1 NS — NA Functional Objects
Correspondence Table” in this manual.

2-3-1 NS — NA Functional
Objects Correspondence
Table

How can | unify the aspect ratios of an
image file and an object?

Uncheck the checkbox of [LockAspectRatio]
under [Appearance] in the [Properties] tab page.

2-3-2 Automatic Adjustment
of Aspect Ratio for Image

Value function by the WORD button in
NS)?

enter.

Obijects
Can | create an object that enters a In the [Events and Actions] tab page, select 2-3-3 How To Enter a Fixed
fixed value to a variable (i.e. the Set “SetVariable” as [Actions] and set the value to Value and To

Increase/Decrease a Value

Can |l increase a variable (i.e. the
Increase/Decrease Value function by
the WORD button in NS)?

In the [Events and Actions] tab page, select
“IncreaseVariable” as [Actions] and set the value
to add.

2-3-3 How To Enter a Fixed
Value and To
Increase/Decrease a Value

Can | decrease a variable (i.e. the
Increase/Decrease Value function by
the WORD button in NS)?

In the [Events and Actions] tab page, select
“DecreaseVariable” as [Actions] and set the
value to subtract.

2-3-3 How To Enter a Fixed
Value and To
Increase/Decrease a Value

Can | create an object that is
equivalent to a Multifunction object in
the NS series?

You can set several functions in the [Events and
Actions] tab page.

2-3-4 How To Create
Multifunction Objects

Can | learn about the date and time
formats?

It complies with the date and time format of
Visual Basic. You can also specify an arbitrary
format.

2-3-5 Date and Time Display
Format

Can | change the state of a button
object by not only pressing it down but
also the value of an address?

You must combine a button with a lamp to make
a single button. At that time, set the button
transparent and specify the appearance with the
lamp.

2-3-6 Changing the State of
the Button Object

Which NA object corresponds with the
message indicator function of the NS
series?

The Data Lamps do. Unlike the NS-series, you
cannot specify a different size or type of the font
for each state.

2-3-7 How To Create a
Message Indicator

Can | remove gradation of a Lamp
object? (the upper right corner of the
Lamp object shown below)

It is not possible to remove gradation from a
Lamp object. However, part of the Lamp
functions can be substituted by specifying
[ColorChange] in the [Animations] tab page for a
graphical object.

2-3-8 How To Create a Lamp
Object with No Gradation




Questions

Answers

Details described in:

How can | show a decimal pointin a
Data Display object (i.e. the scale
setting in NS)?

Enter a computational expression in
[Expression] under [Behavior] in the [Properties]
tab page.

2-3-9 Decimal Display of
Integer-type Values

How can | deactivate the popup that
comes up when selecting an already
raised alarm event?

Uncheck the “Popup” checkbox of the User
Alarm.

2-3-10 Alarm Objects

Cannot distinguish the raised alarms
from the reset alarms by default. How
can | do it?

Add “Status” to [ColumnTitles], [ColumnOrder],
and [ColumnWidths] under [Appearance] in the
[Properties] tab page.

2-3-10 Alarm Objects

How can | set a macro equivalent to
the one that is run in NS upon loading
a project?

In the Global Events menu, set a subroutine that
is created for “Projectlnitialzation”, the condition
to start up the project.

2-4-1 How To Specify
Subroutines (Macro) in the
System Settings

How can | set a macro equivalent to
the one that is run in NS when an
alarm event is raised or reset?

Set a subroutine that is created for an event and
action of each user alarm.

2-4-1 How To Specify
Subroutines (Macro) in the
System Settings

How can | set a macro equivalent to
the one that is run in NS when a value
is changed?

In the Global Events menu, set a subroutine that
is created for “Condition”, the condition for a
value to change.

2-4-1 How To Specify
Subroutines (Macro) in the
System Settings

Is it possible to connect an NA with a
CJ-series CPU?

You can connect the target CPU by registering it
as an external device. At this point, only
Ethernet connection is supported (i.e. the NA
units do not support serial connection).

2-4-2 Connecting with the
CJ-series CPU

Is it possible to switch the screen from
the PLC? Is it also possible to report
the current screen from NA to PLC?

On the NJ, specify a String-type variable and
assign it to “_HMI_CurrentPage”, a system
variable that specifies the current screen. You
can change the screen by entering the name of
the destination screen in the variable assigned
to the system variable. If the address values are
directly linked with the page numbers as in NS
series, you must write Visual Basic.

2-4-3 How To Switch the

Screen by the PLC Variables




2 Questions and Answers

This chapter provides questions and answers that arise when you edit pages of the NA. The
questions and answers are classified into the three categories including the system settings,

the settings common to objects, and the settings unique to each object.

2-1 System Settings

I 2-1-1 Differences between NS and NA

The following table shows the major differences between NS and NA.

ltems

NS

NA

Maximum number of
sheets that can be applied
to a single screen

*In NA, itis called a
background page.

10 sheets

1 sheet

Note, however, that in NA the basic screen
to which the sheet is applied can also be
used as a sheet. As a result, multiple
sheets (pages) can be applied to a single
screen.

Settings of the clock built in
the PT

Entry is possible from a date or time object
or from the system memory, in addition to
the system menu.

You cannot perform input from a date or
time object. Need to perform settings from
the system menu. The system variable for
date and time is available, but it has been
specified for reading only.

System ten key

You can enter Japanese texts (including
Chinese characters) with the text input ten
key.

At this point you cannot enter Japanese
from the text input ten key. You must
create a user ten key.

The version upgrade scheduled in
September includes implementation of the
function to input Japanese.

User-defined ten key

Users can relatively create a ten key by
using a command button or a [key button]
as a multifunctional object.

Although users can create a ten key, you
must use Visual Basic. The version
upgrade scheduled in September includes
implementation of the function to edit the
system ten key.

Number of popups
displayed

Up to three popups can be displayed at a
time.

Only a popup can be displayed.

Macro
*In NA, itis called a
subroutine.

NS uses its own scripts.

NA adopts Visual Basic 2008. Part of the
functions is limited or expanded.




I 2-1-2 How To Display the Properties Tab

By default, the tabs of Properties and other aspects are not displayed. To display these tabs,

select an item to display from the [View] menu. (See the figure below.)

On Sysmac Studio Ver1.11 and later, you can display the Properties tab by double-clicking

the object.

New Project - HMI_NAS_D - Sysmac Studio

File Edit View Insert Project HMI Simulation Tools Help

Multiview Explorer

Toolbox

Output Tab Page

Watch Tab Page

Cross Reference Tab Page

Build Tab Page

Search and Replace Results Tab Page

Page Explorer
Code Explorer

Alt+1
Alt+2
Alt+3
Alt+4
Alt+5
Alt+6

Alt+7

Ctrl+Shift+1
Ctri+5Shift+2

The icons

signify

Properties
Animations
Events and Actions

Ctrl+5Shift+3
Ctri+5Shift+4
Ctri+5hift+5

from the left.

Smart Project Search
Recently Closed Windows

Clear Recently Closed Windows History

Zoom

Reset Window Layout

Ctri+5hift+F

You can also use the icons (enclosed in
the red rectangular above) under the
menu bar to show the tabs.

Properties,
Animations, and Events and Actions

Ctri+Shift+H

I 2-1-3 How To Display Description of Objects

By default, the descriptions of objects are not displayed. To display them, select
“Description” from the context menu.

Select “Description” from the context

menu.

v Behavior

Scaliry

» Colo
v Lavou REaEt

 p—

» Size [Width,HeightJ
¥ Security
VisibilityLevel
Properties

The description is displayed at the

bottom of the tab. Repeat step 1 to hide

the description.

v Behavior

Scaling

» ColorRanges
¥ Layout
» Position (Left, Top)

60, 120

Expression
Expression that evaluates to a numeric value. This value is
used to select which threshold to use.
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2-2 Functions Common to Objects
This section describes the functions that are common to several objects.
I 2-2-1 Settings to Enable Input

This subsection describes how to perform in the NA series the settings that are equivalent to
the function of enabling input in the NS series.

Command Button - PBCO001

Gieneral | Golor/Shape | Label | Frame | Flicker | Write | Password CDntrD|F|ag| Macro | Size/Position | Other |

Ihput

(¢ Enable

" Dizable

 Indirect =

' L

Dizplay

* Dizplay

" Hide

" Indirect Ch

1. Select an object for which to v Behavior
enable input and open the Variable
[Properties] tab. Check or uncheck IsEnabled
the checkbox of [IsEnabled] under
[Behavior] to respectively enable
or disable input. DelayTime

DoubleTouchTime

2. To control input by the state of the  [Animations .1 x
variable, select the target object T
and open the [Animations] tab. egglebution
From [Animations], select “Enable” 'r < Select Animation to Add =
and specify the condition to enable —
input in [Expression]. ¥ [0] Enable -
In the NS series, all you can do to Expression Sample2=True
perform the settings is to turn ON
or QFF the bit address. In the NA Animations
series, however, you can also
specify the condition by numeric ToggleButton0

values. ¥ Animations = Selact Animation to Add =

v [0] Enable o

11



I 2-2-2 Show/Hide Settings

This subsection describes how to perform in the NA series the show/hide settings that are
equivalent to the function in the NS series.

Command Button - PBC0O001

Gereral | Golor/Shape | Label | Frame | Flicker | Write | Password | | Macro | Size/Position | Other |

Thput

f* Enable

" Dizable

" Indirect O

| i

Dizplay

{* Display

" Hide

" Indirect O

:

Select an object for which to TextColorButtonUp
perform settings, and open the
[Properties] tab. Check or TextColorButtonDown

uncheck the checkbox of e _ ) -
Ly e ———— BackgroundColorButtonU [ IEELEEL

respectively show/hide the BackgroundColorButtonC [ IEELEEL v
object. .
Beware that, while in the NS BorderColorButtonUp ] Linear -

series the functions of the object
work even if it is hidden, the

hidden objects in NA series do BorderThickness 2
not operate even if it is touched.

BorderColorButtonDown || JEREEY M

CornerRadius (X,Y) 0,0
Isvisible

If you wish to hide an object while =5 =G0 | | Transparent 1
keeping its functions available,
set all the parameters to specify  PaattE=NuGLELENE | | Transparent "
the colors (enclosed by the red . ~ | i
et D 10 (6 (el G G BackgroundColorButtonU JIRRIELS S

right) to “Transparent”.

BackgroundColorButtonC SEERIENEELE b

BorderColorButtonUp [ | Transparent .

BorderColorButtonDown JIRRIENEELE 1

To control show/hide of an object | animatians - 0 x
by the state of the variable, select
the target object and open the
[Animations] tab. From
[Animations], select “Visibility” v [0] Visibility
and specify the condition to show
the object in [Expression]. Expression Sample2=False

ToggleButtonl

1 < Select Animation to Add =




I 2-2-3 Settings to Blink an Object

This subsection describes how to perform in the NA series the settings for what is called as

Flicker in the NS series.
The function is called “Blink” in the NA series.

Command Button - PBCO001

Gieneral | Cialor#Shape | Label | Frame Flicker | Wit ite: | Passward | Ciontral Flag | Macra |

Elicker Mo |Flicker No.l x| Set Flicker{1}..

Flicker Timing

" When Address OMN

| ). |

Select an Ob_jeCt for which to Animations < Select Animation to Add > -
perform settings, and open the _
[Animations] tab. From Blink
[Animations], select “Blink”. Enable
Mowve
ResizeHeight
ResizeWidth
Visibility

Specify the condition to blink the
object in [Expression], and specify
the color for blinking in [Color]. v [0] Blink
Unlike the NS series, you T <o nplel=True
cannot change the blinking
speed.

< Select Animation to Add = -

Color B Red

To constantly blink the object, ¥ Animations < Select Animation to Add >  ~
select “True” in [Expression].

v [0] Blink i

Expression True

e -

13
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I 2-2-4 Differences between Variable, Expression, and Value

The title of the field in which a variable is assigned for an object varies from [Variable] to
[Expression] to [Value], depending on the object or item.

The indication of [Variable] is mainly used by the objects such as Data Edit or Button that
write values. You can only set a variable in this field.

The indication of [Expression] is mainly used by the objects such as Data Display or Lamp
that read values, in the fields for specifying startup conditions or display targets. You can set
arithmetic expressions in addition to variables.

The indication of [Value] is mainly used by the objects that write fixed values or variable
values. While you can only set a variable in the [Variable] field, you can also enter an
arithmetic expression in this field. Thus, you can enter a value obtained by adding a fixed
value to a variable value.

Variable: Only a variable can be set.
IsEnabled

DataType Mumeric -

Variable SampleA

Expression: An arithmetic expression can
be entered in addition to variables.
DataType MNumeric - DataType Mumeric -
Expression SampleA Expression SampleA f10

Value: As is the case with Expression, an arithmetic expression can be entered in
addition to variables.

* In the example below, the value obtained by adding Variable “SampleB” and
Variable “SampleC” is stored in Variable “SampleD”.

SiELE] < SelectEventio Add = =} | [Expression] is mainly used in the
¥ [0] Press @ { | [Properties] tab, and [Value] in
¥ Actions < Select Action to Add > -1 | the [Events and Actions] tab.
v [0] SetVariable 5 The figure on the left shows the
settings on the [Events and
Actions] tab for a Label object.

AV SampleD

Value sampleB+SampleC

In [Expression] and [Value], you can use exponentiations and remainders besides
the four arithmetic operations.

SampleA+1
SampleB+SampleC SampleA-1
H#HHHHE SampleA~2 (exponentiations)

SampleA mod3 (remainders)



2-3 Functions Unique to Each Object

This section describes the functions of the individual object.

I 2-3-1 NS - NA Functional Objects Correspondence Table

The following table shows correspondence between NS functional objects and NA objects.

NS Functional Objects

NA Objects

Remarks

ON/OFF Buttons

[Buttons]-[Momentary Button]

value.

(Momentary)

ON/OFF Buttons [Buttons]-[Toggle Button]

(Alternate)

ON/OFF Buttons [Buttons]-[Set Button]

(Set)

ON/OFF Buttons [Buttons]-[Reset Button]

(Reset)

Word Buttons In [Events and Actions], select You can specify the events and actions for not
(Set Value) [SetVariable] and specify an input only Buttons but also Labels or Shapes.

Refer to “2-3-3 How To Enter a Fixed Value and
To Increase/Decrease a Value”.

Word Buttons
(Increment/Decrement)

In [Events and Actions], select either
[IncreaseVariable] or
[DecreaseVariable] and set a value.

You can specify the events and actions for not
only Buttons but also Labels or Shapes.

Refer to “2-3-3 How To Enter a Fixed Value and
To Increase/Decrease a Value”.

Word Buttons
(Display Pop-up menu)

[Standard Controls]-[DropDown]

Command Buttons
(Switch Screen)

In [Events and Actions], select
[ShowPage] and determine the
destination page.

You can specify the events and actions for not
only Buttons but also Labels or Shapes.

Command Buttons
(Backward)

In [Events and Actions], select
[ShowPreviousPage].

You can specify the events and actions for not
only Buttons but also Labels or Shapes.

Command Buttons
(Key Buttons)

No substitution exists at this point on an object
basis. Part of the functions, however, can be
reproduced with the use of Visual Basic.

Command Buttons
(Control Pop-up Screen —
Close Pop-up Screen)

In [Events and Actions], select
[ClosePage] and specify the screen to
close.

Bit Lamps

[Lamps]-[Bit Lamp]

Word Lamps

[Lamps]-[Data Lamp]

Multifunction objects

No particular object exists. You can create an
object that has multiple functions by specifying
several events and actions for the object.
Refer to “2-3-4 How To Create Multifunction
Objects”.

Text objects

[Standard Controls]-[Label] or [TextBox]

Use Label for a single row, or TextBox for
multiple rows.

Unlike the NS series, you can specify the events
and actions to perform input operations such a
writing a value in a variable.

Message Indicator Function
(Text objects)

[Lamps]-[Data Lamp]

Unlike the NS series, you cannot specify a
different font type/size for each state. However,
you can specify a different background/text color
for each state.

Refer to “2-3-7 How To Create a Message
Indicator”.
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NS Functional Objects

NA Objects

Remarks

Numeral Display and Input
objects

String Display and Input objects
(Enable to input)

[Standard Controls]-[Data Edit]

Numeral Display and Input
objects

String Display and Input objects
(Unable to input)

[Standard Controls]-[Data Display]

The Numeral Display and Input objects and
the String Display and Input objects have
been reorganized to be the Data Edit objects
and Data Display objects.

List Selection objects

[Standard Controls]-[ListBox]

Thumbwheel Switches

No substitution exists on an object basis. A
similar function can be created by combining
a numeric object and the events and actions
of a button object.

Analog meters

Gauges

Level meters

Gauges

Broken-line Graph objects

No corresponding object/function
exists at this point. To be supported in
the next version upgrade.

Bitmap objects

[Standard Controls]-[Image]

Alarm/Event Display object

No corresponding object/function
exists.

Alarm/Event Summary and
History object

[HMI Controls]-[User Alarms Viewer]

In the NS series, you can display
alarms/events by only specifying the group
or display type. In the NA series, however,
no corresponding function is available at this
point.

Date objects

[Standard Controls]-[DateTime]

You can display date only.

While the NS series allows direct date
settings from an object, the NA series only
allows settings from the system menu.

Time objects

[Standard Controls]-[DateTime]

You can display time only.

While the NS series allows direct date
settings from an object, the NA series only
allows settings from the system menu.

Data Log Graph objects

[HMI Controls]-[Trend Graph]

Data Block Table objects

[HMI Controls]-[RecipeViewer]

Video Display objects

[HMI Controls]-[Media Player]

Temporary Input objects

No corresponding object/function
exists.

Consecutive Line Drawing

[Shapes]-[Polyline]

Contents Display objects

[Lamps]-[Data Lamp]

You can create a similar function using a
Data Lamp.

There is a limitation, however, of being
unable to specify a different text color or font
for each state.

Frames

No corresponding object/function
exists at this point. To be supported in
the next version upgrade.
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I 2-3-2 Automatic Adjustment of Aspect Ratio for Image Objects

When you use an external image for a Button or Lamp object, the aspect ratio of the object
and the image is automatically adjusted. As for the default of an Image object, however, the
image’s original size is kept when it is displayed.

Following is the procedure to automatically adjust the aspect ratio.

By default, when you set an image
to an Image object, the height
matches the object whereas the
width does not, producing blanks
on both ends.

Select the Image object and open ¥ Appearance

the [Properties] tab. Uncheck the _
checkbox of [LockAspectRatio] | HEEA 0CM00030.bmp

under [Appearance].

IsVisible

The image’s aspect ratio matches
that of the object.
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I 2-3-3 How To Enter a Fixed Value and To Increase/Decrease a Value

To enter a fixed value or to increase or decrease a value in a variable or address in the NS

series, you use a Word Button.
In the NA series, you use Events and Actions.

® Entering a Fixed Value

1. Select [Buttons] — [Button] in the S s
Toolbox. Drag and drop it to the

page.

Momentary Button

Reset Button
Set Button

Toggle Button

2. Inthe [Events and Actions] tab B Eyents e e
page, select “click” as [Events] -
and “SetVariable” as [Actions]. ¥ [0] Click ]
Then, set a target.varlable . . ¥ Actions = Salect Action to Add = -
[Variable] and an input value in
[Valuel]. ¥ [O] setVariable i
Variable SampleA
Value 10
3. Youcan indir.ectly spgcify the input ¥ Events < Select Event to Add = =
value by setting a variable instead
of a fixed value in [Value]. ¥ [0] Click a
The example on the right shows - P
the value of Variable SampIeC is ¥ Actions < Selact Action to Add > -
entered in SampleB. v [0] SetVariable &
Variable SampleB
SampleC

18



® Increasing/Decreasing a Value

Select [Buttons] — [Button] in the ¥ Buttons

Toolbox. Drag and drop it to the
page.

Reszet Button
Set Button

Toggle Button

In the [Event‘&“, a.nd"ActlonS] tab ¥ Events = Select Event to Add = -
page, select “click” as [Events]
and “IncreaseVariable” as v [0] Click [
[AcltlonS]; Then., set a target ¥ Actions < Sglact Action to Add =
variable in [Variable] and an
increment value in [Value]. v [0] IncreaseVariable i
Variable SampleB
Value 1
!‘:or SUbtraCtio@ Se,l,eCt . L4 Events < Select Event to Add > ~
DecreaseVariable” as [Actions] -
and set a decrement value in ¥ [0] Click a
[Value]. ¥ Actions < Select Action to Add = -
¥ [0] DecreaseVariable a
Variable SampleB
Value 1
You can indirectly specify the Buttonl

increment/decrement value by
setting a variable instead of a fixed
value in [Value]. ¥ [D] Click (1]

¥ Evenis « Select Event to Add = -

¥ Actions = Sefact Action to Add = -

[=]]

¥ [0O] IncreaseVariable

Variable SampleB

Value SampleC




I 2-3-4 How To Create Multifunction Objects

In the NS series, there exist the Multifunction objects that have multiple functions within the
single object. In the NA series, by contrast, such objects that are dedicated for multifunction
do not exist. You can realize multifunction, however, by assigning multiple events and
actions to a single object.

1. Select [Buttons] — [Button] in the "
Toolbox. Drag and drop it to the
Momentary Button
Reset Button
Set Button
Toggle Button
2. Inthe [Event? and,,ACtlonS] tab ¥ Events < Select Event to Add = -
page, select “click” as [Events]
and “SetVariable” as [Actions]. ¥ [0] Click i
Then, set the target variable in —— T ——
[Variable] and an input value in Ll = Select Action fo Agd =
[Value]. ¥ [0O] SetVariable a
Variable SampleB
Value 10
3. Subsequently select Events and Actions .1 x
“SetVariable” as [Actions] and
. . . Button1
set a target variable in [Variable] el
and an input value in [Value], ¥ Events < Select Event to Add = -
both of which are different from v [0] Click &
those set in Step 2 above.
¥ Actions < Select Action to Add = -
¥ [0] SetVariable i
Variable SampleB
Value 10
‘r SetVariable ]
Variable SampleC
Value 20
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I 2-3-5 Date and Time Display Format

While the NS series has the respective independent date and time objects, the NA series
has the integrated data and time display objects. You can still display only date or time by
specifying the format.

15 types of formats are available. The users can arbitrarily specify one of them.

In addition in the NS series, you can set the clocks built in the PTs by specifying input
permission for either a date or a time object. In the NA series, however, you cannot specify
time from a DateTime object.

Formats Display Examples (for 13:08:54 on June 5™
2015)
ShortDatePattern 06/05/2015
LongDatePattern Friday,05 June 2015

FullDateShortTimePattern

Friday,05 June 2015 13:08

FullDateTimePattern

Friday,05 June 2015 13:08:54

ShortDateTimePattern 06/05/2015 13:08
ShortDateLongTimePattern 06/05/2015 13:08:54
MonthDayPattern June 05

Rfc1123Pattern Fri,05 June 2015 13:08:54 GMT
SortedDateTimePattern 2015-06-05T13:08:54
ShortTimePattern 13:08

LongTimePattern 13:08:54

UniversalSortedDateTimePattern

2015-06-05 13:08:54Z

UniversalSortedDateTimePattern

Friday,05 June 2015 04:08:54

YearMonthPattern

2015 June

UseCustomDateTimePattern

User-defined setting '

*1: Users can arbitrarily specify [CustomFormat] as shown below.

¥ Appearance

Format

CustomFormat

UseCustomDateTimePattern

yyyy/MM/dd HH:mm:ss

O Setting Examples for UseCustomDateTimePattern

CustomFormat Settings

Display Examples (for 13:08:54 on June 5
2015)

yyyy/MM/dd HH:mm:ss

2015/06/05 13:08:54

yy-MM-dd dddd HH:mm:ss dddd

15-06-05 Friday 13:08:54

yy/M/d ddd H:m:s

15/6/5 Fri 13:8:54

MMMM dd tt hh:mm:ss

June 05 PM 01:08:54

MMM dd hh:mm:ss t

Jun 05 01:08:54 P

Note:

The Formats are case sensitive. Thus, if you set as YYYY/MM/DD, the year and date are

not properly displayed.
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I 2-3-6 Changing the State of the Button Object

In the NA series, states of a Button object can only be changed when it is pressed down.
Thus, it does not have the same function of state change by an address as the NS series

does.
To make the behaviors of the Button objects equivalent to those of the NS series, you must
combine the Button object with a Lamp object.

® Changing the State by Turning ON/OFF the Write Address
This is equivalent to Type 1 Buttons in the NS series. The state is not changed when
pressed down, but changed when turning ON or OFF the write address.

1. Select the [Toolbox] tab. On the ¢ Buttons
tab page, select [Lamps] — [Bit
Lamp], then drag and drop it to the ¥ Lamps
page.

@ Data Lamp

» Shapes

p Standard Controls

2. Select the Bit Lamp and open the -

) I eFileOff OCMO00170.b
[Properties] tab page. Specify ragen P
[Appearance] and [Layout] ImageFileOn OCM00171.bmp
arbitrarily.

At the same time, specify the IsVisible
condition to change the state (i.e. Behavior
the write address as defined in

the NS series). Expression Samplel=True

Layout
- Position (Left, Top)
» Size (Width,Height)

3. Select the [Toolbox] tab. On the | ¥ Buttons
tab page, select [Buttons] —
[Momentary Button], then drag and | B Butes
drop it to the page.

(Select a Toggle Button if you
need toggle operation, or a Set

- i E[E Reset Button
Button for set operation. You can . E3  SetButton

select a button to create . Toggle Button

depending on the function.) : e
Momentary Button p Lamps
» Shapes
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4. Setall the parameters to specify

the colors of the Momentary
Button to “Transparent”.

TextColorButtonUp

[ | Transparent

TextColorButtonDown

[ | Transparent

BackgroundColorButtonU

[ | Transparent

BackgroundColorButtonC

[ | Transparent

BorderColorButtonUp

[ | Transparent

BorderColorButtonDown

|:| Transparent

For the behavioral condition of
the Momentary Button, specify
the same variable as that
specified for the Bit Lamp
created in Step 2 above. Adjust
[Position] and [Size] to those of
the Bit Lamp created in Steps 1
and 2.

¥ Behavior
Variable
IsEnabled
DoubleTouchTime
OnDelayTime
OffDelayTime

¥ Layout
- Position (Left, Top)

B Size (Width Height)

Samplel

If the objects are overlapped
with each other, the one in the
back does not operate.
Right-click the Lamp and select
[Send to Back] from the context
menu so that the Button comes
forward.

Bring to Front
Bring Forward
Send Backward
Send to Back
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® Changing the State by Turning ON/OFF the Display Address
This is equivalent to Type 2-1 Buttons in the NS series. The state is not changed when
pressed down, but changed when turning ON or OFF the display address.

1. Select the [Toolbox] tab. On the » Buttons
tab page, select [Lamps] — [Bit
Lamp], then drag and drop it to the ¥ Lamps
page.
@ Data Lamp
b Shapes
¢ Standard Controls
2. Select the Bit Lamp and open the ImageFileOff 0CM00170.bmp
[Properties] tab page. Specify
[Appearance] and [Layout] ImageFileOn OCM00171.bmp
arbitrarily. —
At the same time, specify the IsVisible
condition to change the state (i.e. Behavior
the display address as defined in R _
the NS series). Expression Sample2=True
If you only enter variable name in Layout
[Expression], it is defined as » Position (Left, Top)

accompanied by “=True”.

- Size (Width Height)

3. Select the [Toolbox] tab. On the ¥ Buttons
tab page, select [Buttons] — f
[Momentary Button], then drag and
drop it to the page.

(Select a Toggle Button if you
need toggle operation, or a Set
Button for set operation. You can
select a button to create

1 Button

[ Reset Button

E3  Set Button

Toggle Button

depending on the function.) ' o
Momentary Button [ Lamps

» Shapes

4. Setallthe parameters to specify TextColorButtonUp |:| Transparent A

the colors of the Momentary Button
to “Transparent’. TextColorButtonDown  RENREELE = v

BackgroundColorButtonU SEREENE EIE -

BackgroundColorButtonC SEIREEUEEIE -

BorderColorButtonUp  JINRIELE LG -

BorderColorButtonDown BEIRECUE EIE -
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For the behavioral condition of the Behavior
Momentary Button, specify the write

address as defined in the NS series. Variable Samplel

Adjust [Position] and [Size] to IsEnabled

those of the Bit Lamp created in

Steps 1 and 2. DoubleTouchTime

OnDelayTime

OffDelayTime
Layout
» Position (Left, Top)

B Size (Width,Height)

If the objects are overlapped with
each other, the one in the back does
not operate. Right-click the Lamp
and select [Send to Back] from the
context menu so that the Button
comes forward.

Bring to Front
Bring Forward
Send Backward
Send to Back
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I 2-3-7 How To Create a Message Indicator

In the NS series, there is the Message Indicator that enables its state to be changed by the

value of the variable. In the NA series, you can realize the function by using a Lamp object.
Note, however, that in the NS series you can specify the different font type or color for each
state whereas in the NA series you cannot change the basic settings. You can still change

background or text colors as before.

1. Select[Lamps] - [Data Lamp] in ¥ Lamps
the Toolbox. Drag and drop it to :
the page. Cd Bitlamp
» Shapes
» Standard Controls
2. Select the object and open the o [EBRSEne
[Properties] tab page. Specify Design Rectangle
[Design] under [Appearance] as PRl (T2 R,
“Rectangle” to adjust the size > Font Segoe UL 12, Normal
arbitrar“y_ HorizontalAlignment Center
3. Under [Appearance], specify the Appearance
text, font type, and other :
parameters arbitrarily to change Ll Rectangle M
them from defaults. DefaultText (Default) Default
Font Segoe UI, 18, Normal
HorizontalAlignment Center -
VerticalAlignment Center -
Margins (L, T,R,B) 2,2, 2, 2
WordWrap
DefaultTextColor B Black -
DefaultLampColor B Gray -
BorderColor Il Linear -
BorderThickness 3
CormnerRadius (X,Y) 0,0
IsVisible
4. Set the variable that controls state v Behavior
change in [Expression] under
[Behavior], and click the cross (+) P

in [ColorRanges]. Scaling

ColorRanges
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5. A setting field is added under v Behavior
[ColorRanges]. Set the condition
in [StartValue]. Set also the text in
[Text (Default)], background color Scaling
in [LampColor], and text color in ¥ ColorRanges
[TextColor] for the cases where
the condition specified in
[StartValue] is met. Startvalue 1
The example on the right shows
that if the value of Variable
“SampleA” becomes 1 or greater LampColor [ | white v
the text reads “State 17, the B Red .
background color turns white, and
the text color turns red.

Expression SampleA

¥ [0] ==1 1]

» Text (Default) State 1

TextColor

6. To add more conditions, click the v Behavior
cross (+) in [ColorRanges] to add

Expressi
the setting fields and repeat Step 5. Kpression

Scaling

¥ ColorRanges
» [0]
> [1]
e [2]




I 2-3-8 How To Create a Lamp Object with No Gradation

The NA-series Lamp objects are gradated by default. You cannot make a Lamp of which
appearance is perfectly identical to a Button even if you specify the same color for the Lamp
as that of the Button (see the figure below). You can avoid the gradation by setting [Design]
under [Appearance] to “Image” and importing an external image. You can also substitute the
partial function of a Lamp by using the animation function.

1. Select[Shapes] - [Rectangle] in the
Toolbox. Drag and drop it to the

page. ; J Curve

¥ Shapes

Ellipse
Line
Polygon
Polyline

Rectangle

Trangle

2. Selectthe object and open the

Appearance
[Properties] tab page. Specify EillCol
[FillColor] and [LineColor] under iiiColor
[Appearance], and [Size] under LineColor

[Layout] arbitrarily.
LineThickness

LineStyle
CornerRadius (¥,Y)
IsVisible
Layout

B Position (Left, Top)

B Size (Width,Height)

3. Open the [Animations] tab page.
Select “ColorChange (Boolean)” as .
[Animations]. Blink

ColorChange (Analog)
ColorChange (Boolean)
Enable

Animations < Select Animation to Add = -

Move
ParcentageFill
ResizeHeight
ResizeWidth
Rotate
Visibility
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Specify the condition to change the
background color in [Expression], the
color at the time when the conditions
is “False” in [OffColor], and the color
at the time when the condition is
“True” in [OnColor].

Note that for the Shape objects you
can only modify the color of
background. Unlike the Lamp objects,
you cannot change the color of the
frame.

Animations

< Select Animation to Add =

¥ [0]

ColorChange (Boolean)

[ =]]

Expression

SampleA=True

OffColor

. Red

OnColor

B Blue

To add a label, select [Standard
Controls] — [Label] in the Toolbox.
Drag and drop it to the object that has
been created up until Step 4 to add an
arbitrary text.

As is the case with the Rectangle
objects, you can change the state of
the Label objects by specifying
“ColorChange” in the [Animations]
tab. Except for the frame color, you
can reproduce the function almost
equivalent to that of Bit Lamp objects.

=

DateTime
8  DropDown

%" Image

Like a Data Lamp object, if you wish Animations < Select Animation to Add >  ~
to use a function of switching the state -
depending on the variable value, Blink
select “ColorChange (Analog)” in Step ColorChange (Analog)
3.
ColorChange (Boolean)
Set the variable that controls state = = Select Animation to Add = =
change in [Expression] under
[Animations], and click the cross (+) in 0 ColorChange (Analog) i]
[ColorRanges]. ressio SampleA
0 . Red -
0 +
A setting field is added unde!'_ ) Animations < Select Animation to Add = -
[ColorRanges]. Set the condition in
[StartValue]. Set also the background R ColorChange (Analog) i
color in [Color] for the cases where T SampleA
the condition specified in =
[StartValue] is met. The example on DefaultColor -
the right shows that if the value of _ ;
. L J ColorRan 1 +
Variable “SampleA” becomes 5 or 15
greater, the background color turns v [0] >=5 o
white. To add. more conditions, click startvalue |
the cross (+) in [ColorRanges] to add
the setting fields. Color [ | White v
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I 2-3-9 Decimal Display of Integer-type Values

This is equivalent to the function specified by “Unit & Scale” in the NS series.

At this point, the Data Display objects are the only objects that can display values with a
decimal point for the integer-type variables, with the use of this function. Because the Data
Edit objects cannot be specified by arithmetic operations, if you wish to deal with decimals,
you must specify the data type of the variable as the floating point type.

The following example explains how to set a scale of “0.1” to Variable “SampleA”.

1. Open the [Properties] tab page of a ¥ Behavior

Data Display object, and specify DataType Mumeric

each parameter as shown in the S

figure on the right. Specify the scale EIEELT SampleA /10

in [Expression] and the display Scaling

format in [DisplayFormat]. valueFormat Decimal .

DisplayFormat #RHH -

2. In Step 1 above, if you set “1234” in

Variable “SampleA”, the result is as
shown in the figure on the right.

Input Value

Displayed Result
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| 2-3-10 Alarm Objects

The Alarm Objects in the NA series are significantly different from those of the NS series in
terms of the behaviors by the default settings. This subsection describes the alarm settings
more similar to those of the NS series.

® How To Disable the Popup Screen Upon Confirming Alarms

By default of the NA-series alarm objects, a popup page that includes the alarm’s detailed
information comes up when you touch the raised alarm. Following is the procedure to
disable the popup page.

In the Multiview Explorer,
jame Alam ID | Alarm Code | xpression Priority | Message | Popup | Acknowledge |
select [Group0] under e S N VEN e e R e N -

Alarm2

[HMI]-[User Alarms]. ma Gt o2 et e U Tk vt

Alarm2

Uncheck the checkbox of | Popup | Acknowledge |
“Popup”.
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® How To Display Information on Raised/Cleared Alarms

The default of the NA-series alarm objects does not display information on raised or cleared
alarms. The figure below shows a record including raised/cleared Alarm Messages 1to 3
respectively. However, without indication of raised or cleared, the table is difficult to
understand.

In addition, the NS series can display in a single row an alarm that has been raised and
cleared, whereas the NA series forcibly separates the raised from the cleared to display in
different rows. You can display neither only alarms that have been raised, nor only those
that have been cleared.

Date and Time Message Priority

1. Selecta User Alarm Viewer on the ColumnTitles Date and Time|Message| Priority| Group
Page Editor and open the
[Properties] tab page. (The figure to
the right shows the default settings.)

ColumnOrder Time|Message|Priority| Group

ColumnWidths 130.0/300.0]80.0]200.0

2. Add “Status|” before [ColumnTitles] | columnTitles 5tatu5|Pate and Time|Message| Priority| Group
and [ColumnOrder]. In
[ColumnWidths], specify arbitrary
width of the item. Since this item is
case sensitive, always capitalize
“Status|”.

ColumnOrder Statuslll"lmelMessagel Priority|Group

ColumnWidths 160.0]410.0]210.0]90.0]70.0

With the above settings, the alarm object is displayed as below:
The information on raised/cleared alarms is shown in the “Status” column.
“Alarm Raised” indicates those that have been raised, and “Alarm Cleared” those cleared.

Date and Time Message Priority
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2-4 Others

I 2-4-1 How To Specify Subroutines (Macro) in the System Settings

The Subroutines in the NA series correspond to the macro functions in the NS series.

Users can arbitrarily write programs to add functions that are not supported by the basic

features.

This subsection describes the procedure in the NA series to execute a macro that could be

specified in the command of [PT] — [Project Properties] — [Macro] in the NS series.

Project Property
Title | Switch Label

| Select Language | Pop—up Menu | Macro Option |

Praject

[~ ‘When Loading a Project

filarm/Event

[~ On timing Alarm/Event occurred

[ On timing Blarms/Event iz cancelled

On change of an address value

When a bit changed Setd

4dfl1d]:

When a value changed Seth

Write the contents of the subroutine on the [SubroutineGroup] tab page under [HMI] —
[Global Subroutines] in the Multiview Explorer.

HMI_NAS_0 (=] i 'Add global subroutines

oller Events

B2 Data Logging

!}‘5 Data Groups

» [ Data
L Glnbhal Fuents
¥ i@ Global Subroutines

- (@l Imported IAGs

MM Scale Transformations
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® Creating the Subroutine That Runs Upon Loading a Project

Following is the procedure to create the subroutine that is executed upon starting up the
system after power is supplied to the NA series.

[Actions] and specify the
subroutine to call in the
[SubroutineName] field.

1. Inthe Multiview Explorer,
select [HMI]-[Global Events].
2. Inthe [Events and Actions] tab .
< Select Event to Add =
page, select Condrton
“Projectlinitialzation” as FikeyPress
[Events]. ZiIEL.k
F2KeyPress
F2KeyClick
F2KeyRelease
F3KeyPress
F3KeyClick
F3KeyRelease
ProjectInitialization
3. Select “CallSubroutine” as

¥ Events < Select Event to Add > |
¥ [0] ProjectInitialization ﬁl
AsyncExecution [ |

¥ Actions < Select Action to Add > YI
v_ Callsubroutine ﬁl

SubroutineName SubroutineGroup0.SampleSubroutinel
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® Creating the Subroutine That Runs Upon Activation/Deactivation of an Alarm Event

In the NS series, a macro can be run upon activation or deactivation of an alarm. In the NA
series, it can also be run even at the timing of confirming an alarm.

In the Multiview Explorer, select
[Group0] under [HMI]-[User
Alarms].

Select the alarm event to which
to assign a subroutine, and open
the [Events and Actions] tab

page.

To execute the subroutine upon = T T, .

occurrence of the alarm, select

“Raised” as [Events]. Similarly, Acknowledged

select “Cle?red‘ to executf upon Cleared

reset, and “Acknowledged” upon i

confirmation. Raised

Select “CallSubroutine” as Events < Select Event to Add = -

[Actions] and specify the - -

subroutine to call in the L Raised ¢

[SubroutineName]. ¥ Actions < Select Action to Add > -
v [0] CallSubroutine a

SubroutineGroup0.SampleSubroutinel
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® Creating the Subroutine That Runs Upon Change of Bit/Value

1. Inthe Multiview Explorer, it s . ‘
HMI_NAS_0 v =] — =
select [HMI]-[Global Events]. .
I
2. Inthe [Events and Actions] tab
page, select “Condition” as e
sl
[EVentS]. FlKeyPress
FlKeyClick
FlKeyRelease
F2KeyPress
F2KeyClick
F2KeyRelease
F3KeyPress
F3KeyClick
F3KeyRelease
Interval
ProjectInitialization
3. Specify the condition of -

subroutine function in the
[Expression] field. Then select
“CallSubroutine” as [Actions]
and specify the subroutine to call
in the [SubroutineName] field.

¥ Events < Select Event to Add > -

v [0] Condition

Expression Samplel=True

AsyncExecution [}

¥ Actions < Select Action to Add >

¥ [0] CallSubroutine

SubroutineGroup0.SampleSubroutinel
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I 2-4-2 Connecting with the CJ-series CPU

The NA series can be connected with the CJ series in addition to the NJ series.

To use the variables of the CJ series in NA, you must specify the CJ-series PLC as the
connected device, and register the variables of CJ into the NA.

Following is the procedure to register the CJ series as the connected device in NA.

1. Inthe Multiview Explorer,
right-click [Device References] and
select [Add] — [External Device].

1
HMI_NAS5_0 v [l

Ll Configurations and Setup

v
» 3l Inten
#* Variable Mapping
LI HMI Settings

2. Double-click [ExternalDevice0] "7 Configurations and Setup
that is created under [Device ¥ i Device Referen
References]. -

» 5l Internal Devices

di.

+* Variable Mapping

3. In the [ExternalDevice0] tab [ Etemaibeviced x] E

page, select “CJ” as [Device] in ¥ Device Conflauration

the [Device Configuration] field. ;Zva:if;:: aeten 5’?’;":33?2’:".??&"”?;33"

Select either “CIP Ethernet” or Device Vendor Omron v || P Address

“FINS Ethernet” as Device Series cl v Timeout 2 B seconds
Communication Driver CIP Ethernet - Encoding us-ascii -

[Communication Driver]. In the
[IP Address] field in the
[Communications Configuration]
field, specify the IP address of
the connected PLC.

Ei Communication Error Indication

There are three ways to register in the NA the variables of the CJ registered as an external
device:

-to import the variables directly from the device or to update the variables,

-to directly enter the variables in the variable table, or

-to copy and paste the variables from a file such as Excel.

Neither way from among those described above allows import of the CJ’s system variables.
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® Importing or Updating the Variables Directly from the Device
This is only available if “CIP Ethernet” is selected as [Communication Driver]. You must
transfer the variable table to the CPU unit in advance.

While the CJ-series CPU and the
computer are connected via an
Ethernet cable, select “Import”. (At
this time, it does not matter even if
“USB” has been selected for
communication setting on the
Sysmac Studio side.)

_ExtEmaIDevicEO x -

¥ Device Configuration

De: onfiguration ————— —~Communications Configuration

Devi me ExternalDevice0 © IP Address @ Route Path

Device Vendor Omron — 1P Address
Dievice Series cl — Timeout

Communication Driver  [CIP Ethernet = Encoding

162 .168.250._ 1

us-ascii

v

E Communication Error Indication

Import Status Not Imported. v

Import Vanables Update Vaniables Import From File...

¥ Device Varables

Comment

The device variables registered
in CJ are imported as shown in
the [Device Variables] field.

¥ Device Configuration

Device Configuration ———————— - Communications Configuration

Device Name ExternalDevice0 © IP Address @ Route Path

Device Vendor Omron — 1P Address
Device Series &) — Timeout

Communication Driver CIP Ethernet - Encoding

192 .168.250. _ 1

us-ascii

L4

Ei Communication Error Indication

Import successful on '2015/09/29 14:12:34' v

Import Variables Update Variables Import From File...

v Device Variables

Data Type Comment
CJ_BitvVall BOOL
€ BitVal2 BOOL
CJ_NumVal INT

In the Multiview Explorer,
double-click [Variable Mapping].

Ll Configurations and Setup
¥ 5l Device References
» &l Internal De
» [T ExternalDevicel

As is the case with registration of
NJ CPU variables, you can
create variables by selecting
“Create Device Variable” in the
context menu.

cel Variable Mapping x

Position | Port |Data Type|
v _!_Conﬁg ured Devices

192168, w ' ExternalDeviced

Variable

Cl_BitVall BOOL ExternalDevice0_CJ_BitVall

| Variable Comment

CJ_BitVal2 BOOL ExternalDeviceQ_CJ_BitVal2

CJ NumVal INT ExternalDevicel_CJ_NumVal

The variables created in Step 4
are automatically registered in
the [Global Variables] tab page.

Glebal Variables x

Data Type | Initial Value | | Retain | Constant | Update Rate Comment
ExternalDeviced_CJ_BitVall Boolean ExternalDevice0.CJ_BitVall ] [ [500 Milliseconds
ExternalDevice0_CJ_BitVal2 Boolean ExternalDevice0.CJ_BitVal2 (] [1 500 Milliseconds.
ExternalDeviced_CJ NuraVal Short ExternalDevice0.CL_ NumVal =] ] |500 Milliseconds
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® Entering the Variables Directly In the Variable Table

You can directly edit the [Device Variables] field.

Beware, however, that in cases where “CIP Ethernet” is selected as [Communication Driver],
if there is discrepancy in the contents of registration between NA and CJ, a tag comparison

error occurs upon data transfer as a result of verification of variable names and data types
with the CJ unit.

¥ Device Configuration

~Device Configuraion ———— ~Communications Configuration ——————
Device Name External Device0 © IP Address @ Route Path
Device Vendor Omron - IP Address 192 . 168.250._ 2

Device Series cl — Timeout B
Communication Driver CIP Ethernet - Encoding us-ascii -

Ei Communication Error Indication

Import Status Not Imported. o

Import Variables Update Variables Import From File...

¥ Device Variables

Data Type Comment
CJ_BitVall
CJ_BitVal2 BOOL
CJ_NumVal INT

® Copying and Pasting the Variables from a File such as Excel

The [Device Variables] field allows direct editing as well as copy and paste from an Excel file
or other text files. When you paste the data, they must have been written beforehand in a
specified format.

Open the variable table of MName | Data Type | Address /Value | Net. Variable | | Usage | Comment
CX-Programmer. Select the area  * PUF BOOL CFo10 Work  Underflow (UF) Flag
to copy and then either select : ki SRR ARG

“ i ] P hl- t-
Copy” from the cor)text menu or _ I
press the C key while holding i

down the Ctrl key to copy the
variables.

Paste the copied data to an B3 - J| cJ Bitval
Excel file. 1 A [ 8 T o [ o [ E F G b
2
3 | C.J BitVall BOOL WO0.00 (o]
4| CJBitvalz BOOL W00 0
5 | CJ NumVal INT 0o [0}
6 (R (Ctrl) ~
7
Change the order of the pasted Al . 5|
data as described below: | — B c D E E
| —
Variable name -> Data type -> < _
Comments -> AT (address) 3 CJ.Bkvelt _|BOOL W0.00
4 CJBitval2 BOOL WO Ot
5 CJ NumVal INT Do
A
Paste the rearranged data to Import Status Import successful on '2015/09/29 14:12:34° v
the [DeVice Variables] field. Import Vaniables Update Vaniables Import From File..,
Make sure that you must copy e
and paste simultaneously the ¥ Device Variables :
four columns from Variable Name Ratalivpe e

C)_BitVall BOOL
CJ_BitVal2 BOOL
CJ_NumVal INT

Name through AT even if the
comment fields are blank.
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I 2-4-3 How To Switch the Screen by the PLC Variables

The “_HMI_CurrentPage” NA system variable stands for the name of the currently displayed

page. The NA’s variable mapping function allows allocation of system variables.
For such settings in which an address value are directly linked with a screen number as in
the NS series, you must write a program in Visual Basic.

® How To Allocate the NJ Variables to the NA System Variables

Declare on the NJ side a bl il
String-type variable in which to =

store page names. : i S
i

In the NA’s variable mapping Variable Mapping X

function, allocate the Position | Port | DataType | Variable | Variable Comment |
) ¥ & Configured Devices

"_HM|_CurrentPage” NA system Sl ol == = | S S SR

variable to the page name b Suctam Variahlac

variable that has been created in |- 'UST)'V"T"'E B
Step 1. (At this time, enter - i T :
manually the system variable

name instead of selecting

automatic input from the context

menu.)

Write the destination page name Watch (Project)

in the variable created on the NJ Controller name Online value
side in Step 1. The screen is PageMame

switched to the corresponding

one.




® How To Allocate the CJ Variables to the NA System Variables

De_CIare on the_C‘J Si_de a ) Mame | Data Type | Address / Value | Met, Variable
String-type variable in which to P UF BOOL CEOL0
store page names. — P WR WORD Ad51

— CJ_BitVall BOOL W0.00  Publication

= CJ_BitVal2 BOOL WO0.01  Publication

] Myyial IMT 00 Pyhblication

— CJ_PageMame STRIMG(E) 0100 Publication I

= _FageMumber INT D10 Publication
Allocate to NA the CJ variable ¥ Device Variables

created in Step 1. Refer to “2-4-2

Connecting with the CJ-series Pame GaallEE Comment AT
CPU” for dgetails on allocation. CJ‘B!WEH BOCL

Cl_Bitval2 BOOL

CJl_NumVal INT

CJ_PageMame STRING(E)

CJ_PageMumber INT

o

¥  bBdernalDevicel

In the NA’s variable mapping
function, allocate the

“ HMI_CurrentPage” NA system C)_Bitvall

variable to the page name L

variable that has been created in sl -
Step 1. (At this time, enter CJ_PageMame G HMI CurrentPage
manually the system variable CJ PageMumber  INT 1_PageMumber

name instead of selecting
automatic input from the context
menu.)

Write the destination page name [ sct New value e |
in the variable created on the CJ
side in Step 1. The screen is
switched to the corresponding

one. I Mewhalue: |Pagel]
|gsc|| [Size :0-8) Edit Address/Type

Addiess D00 ' Setvaue |
W alue: 'ilf'a_gelj' i

Cloze




® Using Visual Basic (Case Statement)

You can use the Case statements of the Visual Basic codes to assign numbers to each
screen and to create the behavior to switch to the screen that corresponds with the number.

modify the “PageNumber” NJ
variable.

Controller name |

1. Declare on the NJ side a "=
1 i 1 1 Data Type I Initial Value | AT | Retain | Constant | Network Publish |

Numerical btype variable to store —— SR T
page numbers. Fagettumeer O OO orotpubin—

2. Allocate on the NA side the Global Variables. X
Vanable declared |n Step 1 Then | Data Type IInitial Vzl | Retain | Constant | Update Rate
declare respectively the Sogiczn

. p . y NJ_1_PageNumber Integer MNJ_1.PageNumber
String-type variable to store page bage Name Sing
names and the variable to store 5
page numbers on the NA side. Samplel Boolean
“Page_Name”: Variable to
indicate page names
“Page_No”: Variable to indicate
page numbers on the NA side

3. In the global subroutine, write the 3?‘5”;’ Fl’ageg‘amﬁe[‘-‘fp‘ _— 15|
code as shown on the right. . CE;CB ase N_-rageniumber 155'5”;’ F;agteg‘”mbs:f'fd o
“ ”, 1?5 elec a5e _ I Lurrentrage

ngeNameSeIe:ct : 5 Page Nama="Page0" 18] Case "Page0’

SWItCh’eS thg NA’s page basedon 7| casel " “ 19 NJ_1_PageNumber=0

the NJ’s variable value. 8 Page Name="Pagel 20/ Case "Pagel”

“PageNumberSelect”: 9| Casel 21 NJ_1_PageNumber=1

reports to the PLC the number 1? Enzasgjﬁtamez Page2 2 CE'SNE;",P?ETN -
. 23 _1 PageMumber=

cprrespondlng to the currently 12| Page No=NJ.1PageNumber 2| End Select

dlSp_layed page. 13 ShowPage(Page_Mame) 25! | End Sub

In either case, to add pages to 14| | End Sub 2.

switch to, increase the conditions

of Case.

4. In the [GIobaI Events] tab page, = Select Event to Add = -
specify the conditions to execute Condition i
the code created in Step 3 as NJ_1_PageNumber<>Page_No
described below: [ —

syncExecution 0

1 . Indicate the State that the NJ’S ¥ Actions < Select Action to Add > -
page n’umber does not equal to v [0] CallSubroutine .
the NAS 2EElE number. SubroutineName SubroutineGroup0.PageNameSelect
2. Specify the name of the — .

. v [1] Condition (i
subroutine to execute. eorecs T ——

. . . X pression Srageswitching=ralse
3. Indicate that the action is A ° oot ﬁ S E
. . SYNCEXeCunon

taken when the page is switched. s _

. ¥ Actions < Select Action to Add > A
4. Specify the name of the . -
subroutine to execute. o Callubroutine g

SubroutineName SubroutineGroup0.PageNumberSelect
5. To switch the page from NJ, Watch (Project)

I Online value | Maodify

PageMumber 1 1

To switch from NA, modify the
“ HMI_CurrentPage” NA system
variable.
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® Using Visual Basic (String-type Array and the “_HMI_CurrentPage” System Variable)
This method combines the “_HMI_CurrentPage” system variable with the user-defined

String-type array variable.

It directly links the page numbers with the array’s element numbers and switches to the
page number that corresponds with the contents of the array variable.

Declare on the NJ side a
Numerical-type variable to store
page numbers, and a String-type
array variable. For the number of
elements of the String-type array
variable, specify the value greater
than the number of pages.

|Initial Valuel AT | Retain | Constant| Network Publish ||

Data Type

PageMame STRING[256] |l [ Do not publish
)| Pagehumber DINT [l [0  [Donot publish
I PageMameAry Array[0..19] OF STRING[255] | (| Do not publish I

Enter the names of the pages as
the initial values of the
String-type array variable.
Beware that you must modify this
field if the page names are
changed later.

Initial Value Setting
PageMameAry[0..18]

Allocate on the NA side the
variables declared in Step 1.
Then, declare the variable to
store page numbers.

¥ User Variables

PageMame STRING[256]

PageMameAry  Arravi0..191 OF STRINGI2551
DINT

HMI_CurrentPage
MJ_1_PageMumber

PageNumber

In the global subroutine, write the
code as shown on the right.

By specifying the variable
indicating the page number in the
position for the element number
of the String-type array variable,
the screen is switched to the one
that corresponds to the page
number.

265— Sub PageChange

2? _HMI_CurrentPage=NJ_1_PageNameAry(MN)_1_FageMumber)
28 Page_Mo=MNJ_1_PagezMumber

29, | End Sub

In the [Global Events] tab page,
specify the conditions to execute
the code. The figure on the right
shows that the code created in
Step 4 is executed every 100
msec.

Interval

(=1}

Interval 100 Milliseconds -

AsyncExecution [}

¥ Actions = Select Action to Add > -

v [0]

CallSubroutine

(=1}

SubroutineName

SubroutineGroup0.PageChange

Changing the “PageNumber” NJ
variable switches the screen to
the page that has been
registered as an initial value for
the array variable created in Step
2.

Example: When “2” is entered,
the screen is switched to Page2.

Initial Value Setting
PageNameAry[0..19]
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® Using Visual Basic (Switching the Screens by the “Page” Variable)

By default, the page name is automatically specified as “Page” followed by the sequential

number, such as “Page0”, “Page1”, ...

You can utilize that to switch screens by fixing the “Page” part while defining the numerical
value part as variable, and modifying the variable value.

Note, however, that you cannot use this method if the page name has been changed from

“PageNumber” NJ variable
switches the screen from the
PLC.

default.

1. Declare on the NJ side a o I
Numer|ca|_type variable to store o STRIN | Initial Value | AT | Rm | Constant . t.nah |
page numbers. ———— = T

2. Declare on the NA side the | DataTvoe | Initial Value |
following variables. MJ_1_PageNumber Integer MJ_1.PageMumber
NJ_1_PageNumber: links with the Page Mo Integer
page number variables set on the Page_Str String ‘Page’

NJ side. Page Mo Str String
Page_No: stores page numbers.

Page_Str: set “Page” as the initial

value. Used in Visual Basic

described below.

Page_No_Str: a String-type

variable that stores the numerical

value part of the Page.

3. In the global subroutine, write the 31/=1Sub PageChange2
code as shown on the right. 32{| ToString : Function to convert strings
By converting the page numbers 33 Page_Me_Str=MJ_1_PageMNumber.ToString
into text strings and linking them 34/| '+ :Operator to connect strings
to “Page”, the initial value of 35] Page_Str=Page_Str+Page_No_Str
“Page_Str”, the text strings such 36/ _HMI_CurrentPage=Page_Str
as “Page0” or “Page1” that 37{| 'Return Page Str to Initial Value
correspond to the page names 38/| Page Str="Page”
are created. The screens can 39{| Page_No=NJ_1_PageMumber
then be switched by assigning 40} | End Sub
the text strings to
“ HMI_CurrentPage”, the system
variable that indicates page
names.

4. Inthe [Global Events] tab page, 3 2] Interval
specify the conditions to execute p— 100 Milliseconds
the code created in Step 3. The e g
figure on the right shows that the —
code created in Step 4 is ¥ Actions < Select Action to Add >
executed every 100 msec. v [0] CallSubroutine

SubroutineMame SubroutineGroup0.PageChange2

5. Changing the value of the Watch (Project)

Controller name | Name I Online value | Maodify

PageMumber 1 1
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® Using Visual Basic (Where CJ is the Connected Device)

When CJ is used as the connected PLC, as is the case with NJ, you can use Visual Basic to

switch screens from PLC.

Declare on the CJ side a
Numerical-type variable to store
page numbers.

Allocate on the NA side the
variables declared in Step 1.
Then, declare respectively the
String-type variable to store
page names and the variable to
store page numbers on the NA
side.

“Page_Name”: Variable to
indicate page names
“Page_No”: Variable to indicate
page numbers on the NA side

CJ PaEeNa me String

CJ_PageMumber Short ExternalDevice.C]_PageNumber
Page_MName String
Page_No Short

Marme | Data Type | Address.-”u‘alue| Met, Variable |
- P_UF BOOL CFO10

= P_WR WORD A451

— CJ_BitVall BOOL W0.00  Publication
— CJ_BitVal2 BOOL W0.01  Publication
= CJ_MumVal INT DO Publication
— )] PageMame STRIMGIE] 0100 Publication

L‘:" C) PageMumber INT D10 Publication ||
MName | DataType | Initial Value | AT

CJ_BitVall Boolean ExternalDevice(.C)_Bitvall
CJ_Bitval2 Boolean ExternalDevice0.C)_BitVal2
CJ_NumVal Short ExternalDevice0.C)_NumVal

In the global subroutine, write
the code as shown on the right.
“PageNameSelect”:

switches the NA'’s page based
on the CJ’s variable value.
“PageNumberSelect”:

reports to the PLC the number
corresponding to the currently
displayed page.

In either case, to add pages to
switch to, increase the
conditions of Case.

3— 5ub PageMameSelect

4
5 Case 0

6 Page_Name="Page("

7 Casel

3 Page_Mame="Pagel"

9 Case 2

18 Page_Name="Page2"
11| End Select

12! Page_Mo=CJ_PageMNumber
13 ShowPage(Page_Mame)

14} | End Sub

Select Case CJ_PageMumber

15}
16{-
17,

18
15

23
24

25!
26/

20|
21,
232

Sub PageMumberSelect
Select Case _HMI_Currentpage
Case "PageD”
CJ_PageMNumber=0
Case "Pagel”
CJ_PageNumber=1
Case "Page2”
CJ_PageNumber=2
End Select
End Sub

In the [Global Events] tab page,
specify the conditions to
execute the code created in
Step 3 as described below:

1. Indicate the state that the
CJ’s page number does not
equal to the NA's page number.
2. Specify the name of the
subroutine to execute.

3. Indicate that the action is
taken when the page is
switched.

4. Specify the name of the
subroutine to execute.

v [1]

Events

< Select Event to Add =

Expression

CJ_PageNumber <> Page_No

< Select Action to Add =

¥ ACticnr‘lS
» [0] ’

Callsubroutine(”SubroutineGroup0.PageNameSelect™)

Condition

Expression

HMI_IsPageSwitching=False

< Select Action to Add >

¥ Actions
» [0] :

Callsubroutine(”SubroutineGroup0.PageNumberSelect™)
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To switch the page from CJ,
modify the “PageNumber” CJ
variable.

To switch from NA, modify the
“ HMI_CurrentPage” NA
system variable.

-

Set New Value

e

Address: |D‘| 0

SetWalue |

Walue: [&0

Mewiy alue: I1|

Cloze |

Edit Addreszz/Tupe

i

Binary »»
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